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1 Introduction  

The PME GPS 0100 is a precision time server for the Schneider Electric x80 PAC platform. It 
provides time for network connected devices using both Precision Time Protocol (PTP) and 
Network Time Protocol (NTP). It provides time for direct connected devices using IRIG-B 
time protocol and DCF-77 time protocol.  

 

The PME GPS 0100 communicates across the ethernet backplane. For modules located in 
different racks, the module operating as a time server communicates with modules 
operating as clients through the ethernet ring connecting the racks. The typical error 
between modules located in different racks is less than 1 microsecond.  

The PME GPS 0100 has both 5 VDC and 24 VDC time code outputs.  Each output is 
individually programmable for 2 different time codes. 

• IRIG-B 

• DCF - 77 

The PME GPS 0100 has been specifically designed to operate with the Schneider Electric 
BMX ERT 1604 Time Stamp module.  The ERT module requires either a 5 VDC IRIG-B or 24 
VDC DCF-77 time code signal. The GPS module will supply either.  

 

1.1 Operating Modes 

The PME GPS 0100 will operate in one of three modes depending on its configuration 
settings and the GPS receiver signal to the module. 
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• When connected to a GPS 400 or GPS 500 receiver, the PME GPS 0100 will 
synchronize its internal clock with the GPS satellite and operate as a PTP master 
clock.  

• When no GPS receiver is connected or when it is not able to receive a valid GPS 
signal, the PME GPS 0100 will operate as a PTP slave clock and search for a PTP 
master clock on the network. If multiple PTP master clocks are available, it will track 
up to 5 master clocks and select the one with the most accurate clock.  

• In some applications absolute time is not important but relative time between 
devices is important. In these applications the PME GPS 0100 can be configured to 
operate as a master clock using its internal crystal oscillator as a time base.  

1.2 Time Sources 

The PME GPS 0100 internal clock will derive its time from one of three sources. 

1.2.1 Crystal Oscillator 

When power is applied to the PME GPS 0100, its clock will be set from a battery backed up 
real time clock and it will use a 2 part per million (PPM) Temperature Compensated Crystal 
Oscillator (TCXO) as a time base. 

1.2.2 GPS Receiver 

The GPS 400 and GPS 500 receivers which are used with the PME GPS 0100 provides a 
serial data stream and a 1 pulse per second (PPS) reference to the module. The serial data 
stream provides time, signal quality and position information to the module. The 1 PPS 
reference signal is used to synchronize the PME GPS 0100 clock with the GPS satellite. The 
typical error of a PME GPS 0100 clock while synchronized with a GPS receiver is less than 
500 nS. 

1.2.3 PTP Master Clock 

When no GPS reference is available, the PME GPS 0100 will listen on the network for a PTP 
master clock. If a master clock is found the module will transition from listen mode to slave 
clock mode and synchronize with the PTP master clock. The typical error of a PME GPS 
0100 PTP slave clock is less than 1 uS.  

1.3 Network Time Protocols 

The PME GPS 0100 supports PTP protocol as a master or slave and NTP protocol as a 
server. The PTP protocol is used to synchronize other PTP compatible devices on the 
network. The NTP protocol is used to synchronize M580 controllers. 

1.3.1 Precision Time Protocol 

Precision Time Protocol is a master-slave protocol with no setup. Master clocks announce 
their presence on the network. Slave clocks listen for master clocks and select the master 
clock with the most accurate time. The PME GPS 0100 will track up to five master clocks and 
will fail over automatically should the accuracy of the master clocks change.  
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1.3.2 Network Time Protocol 

Network Time Protocol is a client-server protocol. Each M580 controller will need to be 
programmed with the IP address of the PME GPS 0100 NTP server. 

1.4 Serial Time Protocols 

The PME GPS 0100 has two serial time code outputs. One 5 VDC output and one 24 VDC 
output. Each output can be configured to provide an IRIG-B or DCF-77 time code. 

1.4.1 IRIG-B 

The IRIG-B time code is one of the code formats created by the TeleCommunications 
Working Group of the U.S. military's Inter-Range Instrumentation Group (IRIG), the 
standards body of the Range Commanders Council. It consists of a 100 bit data frame which 
is transmitted once per second. The data is encoded using pulse width modulation. 

1.4.2 DCF-77 

The DCF77 time code was developed for the German longwave standard frequency radio 
station. It consists of a 60 bit data frame which is transmitted once per minute. The data is 
encoded using pulse width modulation. 

1.5 Position 

Both the GPS 400 and GPS 500 receivers provide position information to the PME GPS 0100 
module.  This information is included in the data sent to the M580 controller. The accuracy 
of the position information is determined by the GPS receiver being used and the visibility 
of satellites.  

1.5.1 Single Point Precision (SPP) 

Both the GPS 400 and GPS 500 support SPP. It requires a minimum of 4 satellites to 
calculate a position to an accuracy of 10 meters. 

1.5.2 Satellite Based Augmentation System (SBAS) 

SBAS requires the receiver to receive a differential correction signal from a geosynchronous 
satellite. The GPS 400 receiver supports the WAAS constellation and the GPS 500 receiver 
supports the WAAS, EGNOS and MSAS constellations. Position accuracy of 3 meters is 
possible in SBAS mode. 

1.5.3 Real Time Kinematic (RTK) 

RTK requires the use of a multi frequency receiver that can measure the phase difference 
between two different satellite signals. It then uses this phase measurement along with an 
error signal from an RTK base station to calculate a position accurate to 2 cm. The GPS 500 
receiver supports RTK.  

https://en.wikipedia.org/wiki/Inter-Range_Instrumentation_Group
https://en.wikipedia.org/w/index.php?title=Range_Commanders_Council&action=edit&redlink=1
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2 DIO Overview 

The PME GPS 0100 operates as an Ethernet/IP DIO device to the M580 CPU. This means 
that the I/O data communication between the M580 CPU and the PME GPS 0100 is done by 
means of an Ethernet/IP data exchange across the backplane. When the module is located in 
the CPU rack, this data exchange happens completely across the Ethernet backplane 
between the CPU and the module. In the case where the module is located in an eRIO rack, 
the exchange happens across the RIO ring from the CPU through the CRA and across the 
Ethernet backplane to the module.  The update time of the I/O Data between the CPU and 
PME GPS 0100 is controlled by the Request Packet Interval (RPI) The RPI is typically 10mS 
and may be adjusted using the DTM of the module. 

2.1 CPU DIO Limitations 

There are several limiting factors concerning DIO use with the M580 PLC. The two most 
common limits are the number of device connections and the number of bytes exchanged. 

2.1.1 DIO Connection Limits 

The different M580 CPU models feature limits on the number of Ethernet/IP (EIP) 
connections, Modbus/TCP (MB) connections and combined EIP+MB connections.  

2.1.2 DIO Byte Count Limits 

Along with limitations on the number of possible DIO devices that may be connected to a 
single M580 CPU, there are limits on the total number of bytes of data exchanged. The actual 
limiting factor will usually be the total number of PLC Input or Output bytes used by the 
DIO. Exceeding the PLC's limit on any of these items will result in a failure to build the 
proposed system inside Unity Pro. The following table shows the limits for M580 CPUs. 

 

CPU Max EIP 

DIO 

Max Modbus 

DIO 

Max DIO 

EIP+MB 

Total Bytes 

DIO Input 

Total Bytes 

DIO Output 

BMEP581020 64 64 64 2048 2048 

BMEP582020 128 128 128 4096 4096 

BMEP582040 64 64 64 2048 2048 

BMEP583020 128 128 128 4096 4096 

BMEP583040 64 64 64 2048 2048 

BMEP584020 128 128 128 8192 8192 

BMEP584040 64 64 64 2048 2048 

 

The PME GPS 0100 module's DTM configures 128 bytes of PLC input data and 28 bytes of 
PLC output data per card. The maximum number of PMEGPS0100 cards that may be 
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installed in a 581020 CPU is limited to 16 cards. This is because having 16 cards exactly 
equals the maximum allowed number of DIO input bytes for the CPU. 

• 16 modules x 128 bytes/module = 2048 bytes 

Notice that the byte limitation includes all DIO connections from the CPU. PME modules + 
Modbus/TCP slaves + Ethernet/IP slaves. Consider a 584040 CPU that is scanning 30 
Holding Registers from each of 15 Modbus/TCP electric meters. This action uses 900 bytes 
of the 2048 PLC inputs available. 

• 15 slaves x (30 register/slave) x (2 bytes/register) = 900 bytes total 

This PLC would then be able to include 8 PMEGPS0100 modules. 

• 2048 – 900 = 1148 available bytes / (128 byes/module) = 8.96 modules 

2.1.3 NOC DIO 

One option to consider when running into DIO byte count restrictions would be to move 
some of the DIO to an BMENOC3*1 module. The NOC is capable of controlling its own DIO 
on its own Ethernet ports. 

NOTE: The PMEGPS 0100module is not supported as DIO in the BME NOC. PME GPS 0100 
modules must be installed as M580 CPU DIO. 

2.1.4 Hot Standby Implications 

The PME GPS 0100 may be used in M580 Hot Standby systems (HSBY) remote Ethernet 
rack. Like most DIO connections, the PLC Input data from a PME GPS 0100 module is not 
“bumpless” during a transfer from Secondary to the new Primary. The Ethernet/IP 
connections will be closed, and the module “Freshness” will drop to 0 during the transfer. 
The data may not be available for several PLC scans after the transfer as the Ethernet/IP 
connections are re-established. 

2.1.5 Remote Rack Mounting Only 

The PME GPS 0100 may only be used in a remote Ethernet rack in a M580 HSBY system. The 
module may not be mounted in either HSBY CPU rack. 
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3 Hardware Installation 

The BME GPS 0100 module can be installed in any BMEXBP backplane. When using the 
BMEXBP1220 backplane slots 3,9,11 and 12 are reserved for X-bus modules. The BME GPS 
0100 has a keying pin on the back of the module to prevent installation in a BMX BKP xxxx 
backplane. To install the module: 

• Hold the module at an angle and insert the two hooks near the bottom of the module 
into the slots at the bottom of the backplane. 

• Swing the module up so that the connector engages the backplane connector. 

• Use a phillips-head screw driver to tighten the screw at the top of the module. Apply 
2 to 4 in-lbs (0.22 to 0.45 N-m) of torque. 

• The installation and removal of the module is allowed with the CPU powered on 
without risk of module damage or disruption of the CPU. 

 

 

3.1 GPS Receiver 

The PME GPS 0100 is designed to work with a GPS 400 receiver. Connection to the receiver 
is made through an RJ-45 jack on the front of the module. The total cable length between the 
module and the receiver can be up to 1,000 ft. The GPS receiver communicates through an 
RS-485 connection at 4800 baud using NEMA protocol. The receiver also provides a 1 Pulse 
Per Second output which is used to synchronize the clock in the PME GPS 0100. The GPS 
400 receiver is powered by the PME GPS 0100 module.  

The RJ-45 connections are as follows: 

1 – TX Data +  5 – 1PPS + 
2 – TX Data -  6 – RX - 
3 – RX Data +  7 – 24 DVC 
4 – 1PPS -  8 – Ground  

WARNING: Make sure that the cable connecting the PME GPS 0100 and the GPS 400 is 
wired correctly before the connection is made. An incorrectly wired cable can apply 
24 VDC to the line drivers in the GPS 400 possibly causing damage. 
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The front panel RJ-45 connector contains two LED’s. The RX LED will flash every time a 
valid GPS message is received. The 1PPS LED will flash every time a 1 Pulse Per Second  
signal is received. The RX LED should flash three times per second and the 1PPS LED should 
flash once per second when a GPS receiver is connected and receiving a valid signal from 
the satellite. 

3.2 Time Code Outputs 

3.2.1 5 VDC 

The 5 volt output is an RS-485 signal. Differential operation can be configured by using the 
+ and – output pins. Positive unipolar operation can be configured by using the Common 
and A output pins. Inverted unipolar operation can be configured by using the Common and 
B output pins. The output time code is selectable. The options are: 

o IRIG-B 

o DCF-77 

3.2.2 24 VDC 

The 24 volt output is a positive unipolar output. The time code is selectable. The options 
are: 

o IRIG-B 

o DCF-77 

The 24 volt output can be configured as an inverted output for applications that require an 

inverted unipolar output. 

3.2.3 Interfacing to BMX ERT 1604 

The PME GPS 0100 has been designed to provide the time code required by the BMX ERT 
1604 module. The ERT module requires either a 5 volt differential IRIG-B signal or a 24 volt 
DCF-77 signal. Only one of these inputs should be used at a time. 

 

3.3 Front Panel LED Indicators 

3.3.1 LED Display 

The front panel LED displays the current operational status of the module.  
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The information can be divided into three groups. 

• System Information 

o RUN – The Run LED will be on when the module has completed the 
configuration process and a connection has been established with the CPU. 

o ERR – The Error LED will flash indicating the current state of the 
configuration process. 

1 Flash An LLDP message has been sent announcing the presence of 
the PPME GPS 0100 on the network. Waiting for an LLC 
message from the controller. 

2 Flashes Waiting for DHCP to assign an IP address. 

3 Flashes Waiting for ODVA ARP probe to verify IP address is unique. 

4 Flashes Duplicate IP address detected. 

5 Flashes Waiting for PRM file to download. 

6 Flashes PRM file error. 

7 Flashes PRM zero length error. 

8 Flashes Waiting for session open command. 

9 Flashes Waiting for connection. 

10 Flashes Incorrect Module ID – The PRM is not for a PME GPS 0100 
module. 

11 Flashes Incorrect PRM version. PRM major version level should 
match PRM GPS 0100 major version level. 3.xx = 3.xx 

o MASTER – The Master LED will be on when the PME GPS 0100 is configured 
as a PTP Master Clock. 

• Time Source 

o GPS – The module is receiving valid messages and 1 PPS pulses from the GPS 
Receiver. The internal clock is synchronized to the GPS receiver. 

o PTP – The internal clock is synchronized to a PTP Master Clock on the 
network. 

o INTERNAL – The internal crystal-controlled clock is being used as the time 
base. 

• Time Quality 
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o GOOD – The clock has a measured error of less than 100 uS. 

o FAIR – The clock has a measured or calculated error of greater than 100 uS 
but less than 50 mS. 

o POOR – The clock has a measured or calculated error of greater than 50 mS. 

o BAD – The time is based on the internal battery backed-up clock. The clock 
has not synchronized with an external time reference since it was turned on. 

3.3.2 GPS LED’s 

The RJ-45 connector for connecting the GPS receiver has two LEDs. 

• RX – The green RX LED indicates that the PME GPS 0100 is receiving messages from 
the GPS receiver. The LED will flash every time the module receives a message and 
verifies that it was received without an error. This LED should flash three time per 
second 

• 1 PPS – The yellow 1 PPS LED will flash every time the module receives a pulse from 
the GPS receiver. This LED should flash once per second. 
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4 Adding the PME GPS 0100 to Unity Pro 

4.1 Hardware Catalog 

The PME GPS 0100 module is supported in Unity version 8.0 and later. For Unity versions 8 
through 13 the module must be added to the hardware catalog using the Hardware Catalog 
Manager. From the Windows start menu select Hardware Catalog Manager. 

         

 

Select File>Import User Data and then open the file “PME GPS 0100 Rev x_xx.cpx”. This file 
is available for downloading from the Monaghan Engineering web site, www.monaghan-
engineering.com. Select PME_GPS and click on OK. This will add the PME GPS 0100 module 
to the hardware catalog. 

Close the Hardware Catalog Manager and start Unity Pro. The PME GPS 0100 can now be 
chosen from the Hardware Catalog under the “Third party products” section. 

    

 

4.2 DTM Library 

The Schneider Electric x80 PAC platform uses Device Type Manager (DTM) technology for 
interfacing with I/O modules.  The manufacturer of each I/O module provides a DTM which 

http://www.monaghan-engineering.com/
http://www.monaghan-engineering.com/
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describes the operation of the module. Unity uses this information to configure and 
communicate with the module. The DTM for the PME GPS 0100 must be manually added for 
Unity versions 8 through 14.  This is accomplished by using the DTM Update Tool provided 
by Monaghan Engineering which is available for downloading at www.monaghan-
engineering.com. 

After installing the DTM Update Tool, go to the start menu and click on Monaghan DTM 
Update Tool. 

    

The currently installed DTM’s will be displayed. Click Remove to remove the currently 
installed PME GPS 0100 DTM.  

Click Install to select a new version of the PME GPS 0100 DTM to install. 

 

A File Open screen will appear. Select the new PME GPS 0100 XML DTM file.  

 

Verify that this is the correct version and then select Yes or No. 

http://www.monaghan-engineering.com/
http://www.monaghan-engineering.com/
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Start Unity Pro and from the menu select Tools>Hardware Catalog.  In the Hardware 
Catalog screen select the DTM Catalog tab. 

 
 

Click the Update button. A screen will appear saying that the DTM library seems up to date 
and would you like to update it? Click Yes. 

After the update is complete, expand the Vendors heading and select Monaghan 
Engineering. The PME GPS 0100 entry should be visible.
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5 Configuring the PME GPS 0100 with Unity Pro 
This example will demonstrate the steps necessary to configure a PME GPS 0100 module 

with Unity Pro XL V12. 

• The PME GPS 0100 module will be installed in the CPU rack slot 2. 

• The M580 P581020 is the chosen processor. 

• The CPU will be at the default addresses 192.168.10.1 and 192.168.10.11. 

• The PME GPS 0100 will be at address 192.168.10.3. 

5.1 Hardware Setup 

The BME P58 1020 CPU is chosen, along with the BME XBP 0800 eight slot backplane. 

 



   Configuring the PME GPS 0100 with Unity Pro 

monaghan + ENGINEERING PME GPS 0100 14 

After selecting the “PLC Bus” in the Structured View Tree, right click on the Ethernet ports 
of the CPU to open the configuration submodule. 

 

 

The FTP server must be enabled tin the PLC for any PME module to function. The easy way 
to enable the server is to select “Unlock Security”. 

After unlocking the security, click the check box in the tool bar to accept the change. 
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Now close the submodule. After right clicking on slot 2, a “New Device” is added to slot 2. 

 

 

The PME GPS 0100 is selected from the “Third party products” section. 
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The PME GPS 0100 will now appear in the rack. 

 

 

The PLC rack window may now be closed. 

5.2 DTM Setup 

The next step is to force an update of the DTM Catalog. The DTM Catalog is accessed 

through Tools > Hardware Catalog. Select the DTM Catalog tab. 

 

 

Click the Update button. A screen will appear saying that the DTM library seems up to date 
and would you like to update it? Click Yes. 

After the update is complete, expand the Vendors heading and select Monaghan 
Engineering. The PME GPS 0100 entry should be visible. 

Open the DTM browser by selecting Tools>DTM Browser. The DTM Browser will open and 
show a tree with the CPU at 192.168.10.1.  

 

Right click on the CPU and Select “Add”. 
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A window will pop up showing all the installed DTMs. Scroll down until you reach the PME 
GPS 0100 device by Monaghan Engineering. 

 

 

Highlight the PME GPS 0100 entry and press Enter or “Add DTM” to load the DTM for the 
PME GPS 0100 module. A window will pop up with information about the DTM. 

 



   Configuring the PME GPS 0100 with Unity Pro 

monaghan + ENGINEERING PME GPS 0100 18 

At this point the “Alias name” may be modified. This allows you to identify the module by a 
name of your choosing and it can be very handy for shortening the variable names created 
by the DTM. 

 

 

Pressing “OK” will add the DTM device to the DTM Browser. The PME GPS 0100 is now 
added to the tree below the PLC. 

 

 

5.3 Link the DTM to the PME GPS 0100 Hardware 

After adding the DTM it is necessary to link it to the PME GPS 0100 hardware. This is done 
inside the DTM Browser window.  
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Right click on the CPU and select Open. 

 

 

The “Source IP Address” is a pull-down list of all the IP Addresses of the Unity Pro PC. Make 
sure to select an address that is on the same subnet as the M580 CPU and then click Apply. 
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After setting the Source IP address, click on the PME_GPS_0100_... entry in the list on the left 
and select the “Address Setting” Tab.  

 

 

The “Identifier” must be modified to define the exact Rack and Slot occupied by the PME 
GPS 0100 module.   

 

 

In this example, the PME GPS 0100 is located in the CPU rack, Slot 2. Therefore, the 
Identifier must be set for “Mx80_02_PMEGPS01”. The following are the valid entries for the 
Identifier. 

• Mx80_XX_PMEGPS01 – Local CPU rack. 

• CYYY_XX_PMEGPS01 – Remote CRA rack. 
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where, 
XX = Slot number (range 01-11) 
YYY = CRA rack number (range 000 – 159) 

5.4 Configure the PME GPS 0100 Module 

In the DTM Browser, right click on the PME_GPS_0100 and select Open. 

 

 

This will open the DTM configuration screen. Click on the “Application Configuration” Tab. 
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This screen is used to configure the parameters that are downloaded to the PME GPS 0100 
at startup. Most of the selections are enumerated values that are selected by a drop-down 
menu. They are organized in groups by function. 

5.4.1 Global Configuration 

These parameters affect the overall operation of the module. 

• Configuration Source – The configuration parameters for the PME GPS 0100 can be 
downloaded from Unity or they can be entered through a web browser connected to 
the internal web server in the module. The options are: 

o Unity 

o Web 

• Time Zone – The time used by the PTP Server is always International Atomic Time 
(TAI). The time used by the NTP Server is always Coordinated Universal Time 
(UTC). The time sent to the CPU as input data, the time displayed on the web pages 
and the time output in the IRIG-B and DCF-77 time code signals can be adjusted to 
the Local Time Zone. The options are: 

o -12 to +12 

• PTP Mode – In normal operation the PME GPS 0100 will operate as a PTP Master 
Clock if a GPS receiver is connected and receiving a valid signal. Otherwise it will act 
as a PTP Slave. In some applications where absolute time accuracy is not important 
but multiple PME GPS 0100 modules need to be synchronized together, it is possible 
to designate one module as a Master Clock. That module will then use its internal 
crystal controlled clock as a time source for the other modules. The options are: 

o Auto 

o Master 

• GPS Receiver – Select the GPS receiver that is being used with the PME GPS 0100. 
The options are: 

o GPS 400 

o GPS 500 

5.4.2 Daylight Saving Time 

The time used by the PTP Server is always International Atomic Time (TAI). The time used 
by the NTP Server is always Coordinated Universal Time (UTC). The time sent to the CPU as 
input data, the time displayed on the web pages and the time output in the IRIG-B and DCF-
77 time code signals can be adjusted for Daylight Saving Time. 

• Daylight Saving Time Enable – This allows Daylight Saving Time. The options are: 

o No 

o Yes 

• Daylight Saving Start Week – This defines what week of the month Daylight Saving 
Time will start. The options are: 

o First 

o Second 

o Third 
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o Fourth 

o Last 

• Daylight Saving Start Day – This defines the day of the week Daylight Saving Time 
will start. The options are: 

o Sunday to Saturday 

• Daylight Saving Start Month - This defines the day of the Month Daylight Saving 
Time will start. The options are: 

o January to December 

• Daylight Saving Start Time – This defines the time at which Daylight Saving Time 
will start. The options are: 

o 0 to 23 

• Daylight Saving End Week – This defines what week of the month Daylight Saving 
Time will end. The options are: 

o First 

o Second 

o Third 

o Fourth 

o Last 

• Daylight Saving End Day – This defines the day of the week Daylight Saving Time 
will end. The options are: 

o Sunday to Saturday 

• Daylight Saving End Month - This defines the day of the Month Daylight Saving 
Time will end. The options are: 

o January to December 

• Daylight Saving End Time – This defines the time at which Daylight Saving Time 
will end. The options are: 

o 0 to 23 

5.4.3 Time Code Outputs 

Each of the front panel time code outputs is individually programmable. 

• 5 Volt Output Mode – The 5 volt output is an RS-485 signal. Differential operation 
can be configured by using the + and – output pins. Positive unipolar operation can 
be configured by using the Common and A output pins. Inverted unipolar operation 
can be configured by using the Common and B output pins. The output time code is 
selectable. The options are: 

o IRIG-B 

o DCF-77 

• 24 Volt Output Mode -  The 24 volt output is a positive unipolar output. The time 
code is selectable. The options are: 

o IRIG-B 

o DCF-77 
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5.4.4 RTK Configuration 

When using the GPS 500 receiver, the PME GPS 0100 supports RTK position measurements. 

• RTK Mode – In RTK terminology, receivers are divided into two categories. A Base 
Station receiver is placed at a known location and broadcasts correction messages 
that contain the position error calculated from the received satellite signal and the 
receivers know location.  This signal can be received by multiple Rover Stations that 
use the correction message to determine their precise location. The options are: 

o Rover 

o Base Station 

• RTK Protocol - The GPS 500 supports two communications protocols between the 
Base Station and the Rover. The options are: 

o SBP – Swift Binary Protocol. This is the native protocol for the GPS 500 
receiver. 

o RTCM v3 – Radio Technical Commission for Maritime Services version 3. 
This is an industry standard protocol provided for compatibility with other 
manufactures receivers. 

• RTK Communications – The GPS 500 supports three methods of communications 
between the Base Station and the Rover. These options are only valid for a Rover. 
Base Stations always broadcast their messages over both serial and network 
connections. The options are: 

o Serial – An RS-232 serial port connection to the Base Station. 

o Network – An Ethernet connection to the Base Station TCP server. 

o NTRIP – Networked Transport of RTCM via Internet Protocol – An Ethernet 
connection to a 3rd party NTRIP broadcaster.  

• IP Address – The IP address of the GPS 500 receive. The options are: 

o String in xxx.xxx.xxx.xxx format 

• Subnet Mask – The subnet mask of the GPS 500 receiver. The options are: 

o String in xxx.xxx.xxx.xxx format. 

• Gateway – The IP address of the network gateway. The options are: 

o String in xxx.xxx.xxx.xxx format. 

• Base IP Address – The IP address of the Base Station receiver. The options are: 

o String in xxx.xxx.xxx.xxx format. 

• NTRIP User Name – The User Name used to log into the NTRIP account. The 
options are: 

o 16 Character String 

• NTRIP Password – The password used to log into the NTRIP account. The options 
are: 

o 32 Character String 

• NTRIP URL – The URL of the NTRIP server. The options are: 

o 32 Character String 
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5.4.5 Satellite Constellations 

The GPS 500 receiver supports multiple satellite constellations. The U.S GPS satellite 

constellation is always enabled. 

• Glonass – The Russian global navigation satellite system. The options are: 

o Enable 

o Disable 

• Galileo – The European global navigation satellite system. The options are: 

o Enable 

o Disable 

• BeiDou – The Chinese global navigation satellite system. The options are: 

o Enable 

o Disable 

• SBAS – The GPS 500 receiver can use a Satellite Based Augmentation System to 
improve the position accuracy. The options are: 

o Enable 

o Disable 

• Elevation Mask - The GPS 500 receiver can mask satellites below a specified 
elevation to improve position accuracy. The options are: 

o 0 to 60 Degrees 

5.4.6 Inertial Measurement Unit 

The GPS 500 receiver includes an inertial measurement unit that measures linear and 

angular acceleration.  

• Acceleration Range – The full-scale linear acceleration is measured in gravities. 
The options are: 

o 2 g 

o 4 g 

o 8 g 

o 16 g 

• Gyroscopic Range – The full-scale angular acceleration is measured deg/s. The 
options are: 

o 125 deg/s 

o 250 deg/s 

o 500 deg/s 

o 1,000 deg/s 

o 2,000 deg/s 

5.4.7 Surveyed Position 

When used as a Base Station the GPS 500 receiver requires a precise location in order to 

provide correction data for absolute position calculations. Any errors in the surveyed 

position will directly affect the pseudo-absolute RTK position measurement reported by the 
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rover.  This information is not necessary for position measurements relative to the base 

station. This information is not required for rover applications. 

• Surveyed Latitude – This setting represents the latitude of the GPS 500 receiver’s 
antenna, expressed in decimal degrees relative to the equator (north = positive, 
south = negative). The value should be as accurate as possible and should have a 
precision to at least 7 digits following the decimal point. 

• Surveyed Longitude – This setting represents the longitude of the GPS 500 
receiver’s antenna, expressed in decimal degrees relative to the Prime Meridian 
(east = positive, west = negative). The value should be as accurate as possible and 
should have a precision to at least 7 digits following the decimal point. 

• Surveyed Altitude – This setting represents the altitude of the GPS 500 receiver’s 
antenna above the WGS84 ellipsoid, in meters. The measurement should be precise 
to 1 cm. 

 

Now click on the “Process Data” Tab. 

 

 

5.4.8 Requested Packet Interval 

The Requested Packet Interval (RPI) is the time in milliseconds between each data 

transmission from the CPU to the module and the module to the CPU. It is adjustable from 5 

mS to 500 mS.  

5.4.9 Mode 

The PME GPS 0100 can send data to the CPU as either unicast (Point2Point) or multicast 

ethernet packets. The default is unicast. It is preferable to use unicast unless there is more 

than one subscriber to the data.  
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5.5 Build and Transfer 

Build the project, connect to the PLC and transfer the project to the PLC. 

WARNING: Transferring a project to a running PLC may result in injury or death. 

 

5.6 Transfer to FDR Server 

Following any configuration changes within the DTM the project needs to be re-built and 

the DTM data transferred to the FDR Server. This is accomplished by right clicking on the 

PME GPS 0100 entry in the DTM Browser, select “Device Menu”, “Additional Functions” and 

“Transfer to FDR Server”. 

 

 

A confirmation box will show the success of the transfer.  After clicking “OK” another box 

will remind the user to reset the PME GPS 0100 module before the new settings will be 

used. 
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5.6.1 Reset the PME GPS 0100 

There are four ways of resetting the PME GPS 010. 

1. Cycle power to the rack containing the PME GPS 0100. 

WARNING: Cycling power on the rack will also reset every device in the rack 
which may result in injury or death. 

2. The quickest way is to press the “Reset” button on the power supply of the rack 
containing PME GPS 0100. 

WARNING: Pressing the “Reset” button will also reset every device in the rack 
which may result in injury or death. 

3. Remove the mounting screw on the PME GPS 0100 and remove it from the powered 
rack. Re-install the PME GPS 0100 into the rack to cycle power on the module. 

WARNING: Cycling power to the PME GPS 0100 will cause loss of the  modules 
data which may result in injury or death. 

4. Connect to the PME GPS 0100 using the DTM Browser and issue a reset command. 

WARNING: Cycling power to the PME GPS 0100 will cause loss of the  modules 
data which may result in injury or death. 

Right click on the PME GPS 0100 entry in the DTM Browser and select connect. 
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If the connection is successful you will be able to select: Device Menu>Additional 
Functions>Reset Device. 

 

 

A message will ask you to confirm that you want to reset the module. Another 
message box will then confirm that the reset command was sent successfully. 
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6 Web Browser Interface 
The PME GPS 0100 contains an embedded web server. This allows the user to display data 

and configure the module. 

6.1 Sync Status 

The Sync Status page is an overview of the operation of the PME GPS 0100. 

 

• Time Display - The Time display shows the current local date and time. The date 
and time will be followed by DST if daylight saving time is enabled and daylight 
saving time is in effect. 

• Clock Source - The Clock Source display shows which time source is being used by 
the clock for synchronization. 

• Time Quality - The Time Quality display indicates the quality of the time signal 
generated by the clock. The clock continuously measures the error between its 
internal clock and the external time reference. The calculated error of the clock is 
displayed using the following values. 

o Good - The clock has a measured error of less than 100 uS. 

o Fair - The clock has a measured or calculated error of greater than 100 uS 
but less than 50 mS. 

o Poor - The clock has a measured or calculated error of greater than 50 mS. 

o Bad - The time is based on the internal battery backed-up clock. The clock 
has not synchronized with an external time reference since it was turned on. 

• Output Configuration - The Output Configuration display shows the time code 
selected for each output. 

• Clock Status - The Clock Status display shows the status of the PTP clock. 

o Clock State - The current mode in which the clock is operating. 
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Master : The clock is operating as a PTP master clock. 

Slave : The clock is synchronized to a master clock. 

Sync 2 : The clock is in the final stage of synchronizing with a PTP 

master clock. 

Sync 1 : The clock is in the initial stage of synchronizing with a PTP 

master clock. 

Listening : The clock is listening for a PTP master clock. 

o Master Clock ID -  

o Standby Clocks – The number of additional PTP master clocks on the 
network. 

6.2 Statistics 

When connected to a time source the PME GPS 0100 synchronizes its clock every second. 
During the synchronization process the module measures the current clock error and stores 
this information in a database. The data is then displayed as a histogram with each bar 
showing the relative number of samples that fell within each group and the numbers under 
the bars showing the actual number of samples. The display is updated every five seconds. 
Clicking on the Reset button will reset all the counts. 

 
 

The Statistics display above shows the PME GPS 0100 synchronizing with a GPS receiver. 
The display was cleared before connecting the GPS receiver. For the first 182 seconds the 
error was greater than 100 uS. As the clock was being synchronized it  had an error of +10 
uS to +50 uS for 4 seconds, +5 uS to +10 uS for 3 seconds and an error of +1 uS to +5 uS for 1 
second. It then overshot its target and has an error or -1 uS to -5 uS for 654 seconds. It then 
achieved better than 1 uS accuracy and has held that accuracy for 1,886 seconds. 

6.3 Clock 

The Clock page shows the configuration values for the clock. The PME GPS 0100 internal 

clock is always set to UTC. This display provides the conversion factors necessary to 
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maintain the correct time. When the configuration values are provided by Unity, the 

“Submit” and “Reset” buttons will be disabled. 

 

• Time Zone - The time zone control allows the configuration of the offset from local 
time to UTC. 

• Set Current Time – When this button is clicked the web browser will set the PME 
GPS 0100 clock using the computer time of day clock. This button is only effective 
when the PME GPS 0100 is in Internal clock mode. If it is in PTP or GPS clock mode 
the clock will be rest during the next synchronization cycle. 

• Daylight Saving Time Enable - When this box is checked the PME GPS 0100 will 
indicate that the time is daylight saving time when it is in effect. 

• Daylight Saving Start and Stop – The times at which Daylight Saving Time starts 
and stops. 

• PTP Clock Mode – This allows configuration of the PTP Clock Mode 

o Auto – The PTP Clock in the PME GPS 0100 will switch between Master, 
Listen and Slave mode depending the GPS input and the availability of a PTP 
Master Clock on the network. 

o Master – The PTP Clock will always be in Master Mode.  

6.4 GPS 

The GPS page shows all the data associated with the GPS receiver. 
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• Number of Satellites - The number of satellites that the GPS receiver is currently 
receiving. A minimum of three satellites are necessary to calculate the correct time. 

• Signal Quality - One of the following three quality indications will be displayed. 

Good - Differential Fix - The GPS receiver is receiving more than three 

satellites and can calculate the correct time and position. The receiver is also 

receiving a differential correction signal from the WAAS satellite. 

Good - Non-Differential Fix - The GPS receiver is receiving more than three 

satellites and is able to calculate the correct time and position. 

Bad - No Fix - The GPS receiver is not able to calculate the correct position 

or time. 

• GPS Leap Seconds - The number of Leap Seconds reported by the GPS satellite. The 
number of GPS Leap Seconds is always 19 seconds least than the International 
Atomic Time (TAI) Leap Seconds. 

• Latitude – The current latitude in degrees. Positive values are North latitude and 
negative numbers are South latitude. 

• Longitude – The current longitude in degrees. Positive values are East longitude 
and negative values are West longitude. 

• Altitude – The current altitude in meters. 
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6.5 Outputs 

The Outputs page shows the configuration values for the time code outputs. When the 

configuration values are provided by Unity, the “Submit” and “Reset” buttons will be 

disabled. 

 

The time code outputs are individually programmable. The options are: 

• IRIG-B 

• DCF-77 

The 24 volt output can be inverted by checking the “Invert” box. 

6.6 Module 

The Module page shows information about the module. 
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• Hardware Rev – The hardware revision of the module. 

• Software Rev – The software revision of the module. 

• MAC Address – The MAC address of the module. 

• Date of Manufacture – The date the module was manufactured. 

• Runtime – The elapsed time since the module was last reset. 

• Language – The language used for the web pages. The options are: 

• Module Location -  This is a fifteen-character string that is displayed in the upper 
left hand side of each web page. It will be grayed  out if the module has been 
configured by Unity. 

6.7 System 

The System page shows current information about the module’s operating system. This 

page is only accessible from the Module page. 

 

• Dynamic Memory - The Dynamic Memory display shows the current free memory 
in the heap and the minimum free memory since the last reset. These values are 
updated every second. 

• PTP / GPS - The PTP / GPS display shows the current synchronization values. The 
title will indicate the synchronization source. These values are updated every 
second. 

o Error – The calculated error, in nS, for the last synchronization operation. 

o Delay – The calculated delay from the Time Sync Master, in nS, for the last 
Delay Request message. This value is only visible when in PTP mode. 

• EtherNet/IP – The EtherNet/IP resources currently being used. 

o Sessions – The number of sessions currently open. The module will support 
a maximum of 5 open sessions. 

o Connections – The number of connections currently open. The module will 
support a maximum of 15 open connections. 
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• System Log – A log of all the system events. The log contains the last 3,500 system 
events. Up to 64 events are displayed at one time.  

o The Current button will load the most recent events into the System Log 
display.  

o The up and down arrow buttons allow you move through the events stored 
in the System Log. 

o The Report button will download a text file containing 250 events in a 
printable form. The start of the report is determined by the most recent 
event in the display. Use the up and down arrow keys to select the starting 
point of the report and then click on the Report button. 

o The Clear button will clear the System Log. 
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7 Firmware Update 
The PME GPS 0100 firmware can be updated by the user. 

7.1 Unity Loader 

The PME GPS 0100 does not currently support updates using Unity Loader. 

7.2 Boot Loader 

The PME GPS 0100 supports web based firmware updates while in Boot Loader mode. To 

enter the boot loader, insert a paper clip or other small device through the small hole in the 

front panel labeled “Setup”. Depress the switch behind the hole until the front panel LEDs 

start to flash, approximately 5 seconds.  

• 3 Flashes – The module is requesting an IP address from the DHCP server. 

• 2 Flashes – The module has received an IP address from the DHCP server. It will be 
the same address that was assigned by Unity during the module installation. 

• 1 Flash – The module was not able to obtain an IP address from the DHCP server. It 
was assigned a default address of 192.168.16.250. 

7.2.1 Flash 

The Flash page is used to download the new firmware to the PME GPS 0100 module. 

 

Click the “Choose File” button to select the firmware image to load. Click “Program” to start 

the programming process. The front panel LED’s will stop flashing for approximately 5 

seconds while the Flash memory is erased. The program description will then be displayed 

and the Progress indicator will show the percentage complete. 
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After the firmware has been updated the “Download Complete” screen will appear. 

 

The PME GPS 0100 can be returned to operating mode by power cycling the module or by 

inserting a paper clip through the Setup hole until the front panel lights stop flashing, 

approximately 5 seconds. 

7.2.2 Password 

The Password page is used to program a system password for password protected pages. 

There are currently no password protected pages used. 

 

Enter up to a 15 character password and click on “Submit”.
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8 Specifications 

 

Power Requirements 

• 170 mA @ 3.3 VDC 

• 100 mA @ 24 VDC 

Temperature 

• -4°F to +140°F (-20°C to +60°C) 

IRIG-B 

• IRIG Format – IRIG-B 004 

• Bit Rate – 100 pps 

• Modulation – Pulse width code 

• Carrier - No 

• Coded Expression – BCD (Time of Day), BCD(Day of Year),  Code Functions, Straight 
Binary Seconds 

DCF 77 

• Bit Rate – 1 pps 

• Modulation – Pulse width code 

• Carrier – No 

• Coded Expression - BCD 

5 Volt Output 

• Differential RS-485 type 

• Output Drive – Up to 32 modules  

24 Volt Output 

• Unipolar  

• Output signal can be inverted under software control 

• Output Drive – 60 mA 

Timing Accuracy 

• Synchronized to GPS Receiver – +/- 500 nS 

• Synchronized to PTP Master - +/- 1 uS  95% typical 

Network Time Services 

• PTP Master Clock 

• PTP Slave Clock 

• NTP Server
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9 Appendices 

9.1 Precision Time Protocol 

Measurement and automation applications often must precisely synchronize events over a 
widely distributed system. For example, an industrial automation system may need to 
synchronize distributed motion controllers, or a control system may need gather time 
stamped event data from multiple locations. The IEEE 1588 precision time protocol (PTP) 
provides a standard method to synchronize devices on a network with sub-microsecond 
precision. The protocol synchronizes slave clocks to a master clock ensuring that events and 
timestamps in all devices use the same time base. 

9.1.1 IEEE 1588 Technology Overview 

By synchronizing multiple clocks over networks such as Ethernet, IEEE 1588 provides sub-
microsecond synchronization over long distances with standard cabling. There are two 
steps for synchronizing devices using IEEE 1588: (1) determine which device serves as the 
master clock, and (2) measure and correct time skew caused by clock offsets and network 
delays. When a system is initialized, the IEEE 1588 protocol uses the Best Master Clock 
algorithm to automatically determine which clock in the network is the most precise. It 
becomes the master clock. All other clocks become slaves and synchronize their clocks with 
the master. 

 

 
Because the time difference between the master clock and slave clock is a combination of 
the clock offset and message transmission delay, correcting the clock skew is done in two 
phases -- offset correction and delay correction. The master clock initiates offset correction 
using "sync" and "follow-up" messages (see Figure 1). When the master sends a sync 
message, the slave uses its local clock to timestamp the arrival of the sync message and 
compares it to the actual sync transmission timestamp in the master clock’s follow-up 
message. The difference between the two timestamps represents the offset of the slave plus 
the message transmission delay. The slave clock then adjusts the local clock by this 
difference at point A. To correct for the message transmission delay, the slave uses a second 
set of sync and follow-up messages with its corrected clock to calculate the master-to-slave 
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delay at point B. The second set of messages is necessary to account for variations in 
network delays. The slave then timestamps the sending of a delay request message. The 
master clock timestamps the arrival of the delay request message. It then sends a delay 
response message with the delay request arrival timestamp at point C. The difference 
between the timestamps is the slave-to-master delay. The slave averages the two 
directional delays and then adjusts the clock by the delay to synchronize the two clocks. 
Because the master and slave clocks drift independently, periodically repeating offset 
correction and delay correction keeps the clocks synchronized. 

9.1.2 Typical Performance 

Most IEEE 1588 implementations will have sub-microsecond skew, but actual performance 
is highly application-specific. For example, the IEEE 1588 protocol does not specify the 
clock frequency in the master and slaves; thus, lower-frequency clocks have poorer time 
resolution resulting in less-accurate timestamps in the PTP synchronization messages. 
Clock stability is another implementation dependency. Clocks based on temperature-
controlled crystal oscillators (TCXOs) and oven-controlled crystal oscillators (OCXOs) have 
higher stability, usually in the parts per billion, compared with clocks using uncontrolled 
crystal oscillators, with stability in the parts per million. Clocks with lower stabilities will 
drift apart faster, resulting in more frequent frequency and phase corrections or resulting in 
larger skews. Another factor is network topology. The simplest network topology -- two 
devices on a single cable -- provides less network jitter than many devices linked using 
routers and switches. If more than one subnet is required to increase distance or number of 
devices, then a network switch with an accurate IEEE 1588 clock, called a boundary clock, 
becomes the master clock and synchronizes the devices on the subnets. Also, wide 
variations in network traffic may negatively impact clock skew as the delay correction lags 
current traffic conditions. Because many factors can degrade skew performance, 
benchmarking and monitoring actual skew performance over time is recommended. 

9.2 Network Time Protocol 

Network Time Protocol (NTP) is a networking protocol for clock synchronization between 
computer systems over packet-switched, variable-latency data networks. In operation since 
before 1985, NTP is one of the oldest Internet protocols in current use.  

NTP is intended to synchronize all participating computers to within a few milliseconds of 
Coordinated Universal Time (UTC). NTP can usually maintain time to within tens of 
milliseconds over the public Internet and can achieve better than one millisecond accuracy 
in local area networks under ideal conditions. Asymmetric routes and network congestion 
can cause errors of 100 ms or more.  

The protocol is usually described in terms of a client-server model, but can as easily be used 
in peer-to-peer relationships where both peers consider the other to be a potential time 
source. Implementations send and receive timestamps using the User Datagram Protocol 
(UDP) on port number 123. They can also use broadcasting or multicasting, where clients 
passively listen to time updates after an initial round-trip calibrating exchange. NTP 
supplies a warning of any impending leap second adjustment, but no information about 
local time zones or daylight saving time is transmitted. 
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9.2.1 Clock Strata 

NTP uses a hierarchical, semi-layered system of time sources. Each level of this hierarchy is 
termed a stratum and is assigned a number starting with zero for the reference clock at the 
top. A server synchronized to a stratum n server runs at stratum n + 1. The number 
represents the distance from the reference clock and is used to prevent cyclical 
dependencies in the hierarchy. Stratum is not always an indication of quality or reliability; it 
is common to find stratum 3 time sources that are higher quality than other stratum 2 time 
sources. A brief description of strata 0, 1, 2 and 3 is provided below. 

• Stratum 0 - These are high-precision timekeeping devices such as atomic clocks, 
GPS or other radio clocks. They generate a very accurate pulse per second signal 
that triggers an interrupt and timestamp on a connected computer. Stratum 0 
devices are also known as reference clocks. 

• Stratum 1 - These are computers whose system time is synchronized to within a 
few microseconds of their attached stratum 0 devices. Stratum 1 servers may peer 
with other stratum 1 servers for sanity check and backup. They are also referred to 
as primary time servers. 

• Stratum 2 - These are computers that are synchronized over a network to stratum 1 
servers. Often a stratum 2 computer will query several stratum 1 servers. Stratum 2 
computers may also peer with other stratum 2 computers to provide more stable 
and robust time for all devices in the peer group. 

• Stratum 3 - These are computers that are synchronized to stratum 2 servers. They 
employ the same algorithms for peering and data sampling as stratum 2 and can 
themselves act as servers for stratum 4 computers, and so on. 

The upper limit for stratum is 15; stratum 16 is used to indicate that a device is 
unsynchronized. 

9.2.2 Timestamps 

The 64-bit timestamps used by NTP consist of a 32-bit part for seconds and a 32-bit part for 
fractional second, giving a time scale that rolls over every 2^32 seconds (136 years) and a 
theoretical resolution of 2^−32 seconds (233 picoseconds). NTP uses an epoch of January 1, 
1900 so the first roll over will be on February 7, 2036. 

9.2.3 Leap Seconds 

On the day of a leap second event, the NTP server receives notification from either a 
configuration file, an attached reference clock, or a remote server. Because of the 
requirement that time must appear to be monotonically increasing, a leap second is inserted 
with the sequence 23:59:59, 23:59:60, 00:00:00. Although the clock is actually halted during 
the event, any processes that query the system time cause it to increase by a tiny amount, 
preserving the order of events. If a negative leap second should ever become necessary, it 
would be deleted with the sequence 23:59:58, 00:00:00, skipping 23:59:59. 

9.3 IRIG-B Time Code 

Inter-range instrumentation group time codes, commonly known as IRIG time codes, are 
standard formats for transferring timing information. The standards were created by the 
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TeleCommunications Working Group of the U.S. military's Inter-Range Instrumentation 
Group (IRIG), the standards body of the Range Commanders Council. Work on these 
standards started in October 1956, and the original standards were accepted in 1960. 

The original formats were described in IRIG Document 104-60, later revised and reissued in 
August 1970 as IRIG Document 104-70, upgraded later that year as the IRIG Document to 
the status of a Standard, IRIG Standard 200-70. The latest version of the Standard is IRIG 
Standard 200-16 from August 2016. 

9.3.1 Time Codes 

The different timecodes defined in the Standard have alphabetic designations. A, B, D, E, G, 
and H are the standards currently defined by IRIG Standard 200-04.  

The main difference between codes is their rate, which varies between one pulse per 
minute and 10,000 pulses per second. 

IRIG time code 

Code Bit rate Bit time Bits per frame Frame time Frame rate 

A 1000 Hz 1 ms 100 100 ms 10 Hz 

B 100 Hz 10 ms 100 1000 ms 1 Hz 

D 1⁄60 Hz 1 minute 60 1 hour 1⁄3600 Hz 

E 10 Hz 100 ms 100 10 s 0.1 Hz 

G 10 kHz 0.1 ms 100 10 ms 100 Hz 

H 1 Hz 1 s 60 1 minute 1⁄60 Hz 

The bits are modulated on a carrier. A three-digit suffix specifies the type and frequency of 
the carrier, and which optional information is included: 

• Modulation type 
0 - (DCLS) Direct Current Level Shift (width coded) 
1 - Sine wave carrier (amplitude modulated) 
2 - Manchester modulated 

• Carrier frequency 
0 - No carrier (DCLS) 
1 - 100 Hz (10 ms resolution) 
2 - 1 kHz (1 ms resolution) 
3 - 10 kHz (100 µs resolution) 
4 - 100 kHz (10 µs resolution) 
5 - 1 MHz (1 µs resolution) 

https://en.wikipedia.org/wiki/Inter-Range_Instrumentation_Group
https://en.wikipedia.org/wiki/Inter-Range_Instrumentation_Group
https://en.wikipedia.org/w/index.php?title=Range_Commanders_Council&action=edit&redlink=1
https://en.wikipedia.org/wiki/Manchester_code
https://en.wikipedia.org/wiki/Carrier_frequency
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• Coded expressions - Binary-coded decimal day of year, hours, minutes, and (for 
some formats) seconds and fractions are always included. Optional components are: 

o Year number (00–99; century is not coded) 

o User Defined - control functions occupying bits not defined by IRIG 

o Straight Binary Seconds -  17-bit binary counter that counts from 0 to 
86399. 

0 - BCD, CF, SBS 
1 - BCD, CF 
2 – BCD 
3 - BCD, SBS 
4 - BCD, BCD_Year, CF, SBS 
5 - BCD, BCD_Year, CF 
6 - BCD, BCD_Year 
7 - BCD, BCD_Year, SBS 

The recognized signal identification numbers for each format according to the standard 
200-04 consist of: 

Permissible Code Formats 

Format Modulation Type Carrier Frequency Coded Expressions 

A 0,1,2 0,3,4,5 0,1,2,3,4,5,6,7 

B 0,1,2 0,2,3,4,5 0,1,2,3,4,5,6,7 

D 0,1 0,1,2 1,2 

E 0,1 0,1,2 1,2,5,6 

G 0,1,2 0,4,5 1,2,5,6 

H 0,1 0,1,2 1,2 

Thus, the complete signal identification number consists of one letter and three digits. For 
example, the signal designated as B122 is deciphered as follows: Format B, Sine wave 
(amplitude modulated), 1 kHz carrier, and Coded expressions BCDTOY. 

 

https://en.wikipedia.org/wiki/Binary-coded_decimal
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9.4 DCF-77 Time Code 

DCF77 is a German longwave time code signal and standard-frequency radio station. The 
time code broadcast by the station is referred to as the DCF-77 Time Code. 

9.4.1 Bit Definition 

DCF-77 uses pulse width modulation to encode the data bits. A binary 0 is encoded as a 0.1 
second positive pulse starting at the beginning of the second. A binary 1 is encoded as a 0.2 
second positive pulse starting at the beginning of the second. As a special case, the last 
second of each minute is marked by no pulse being generated. 

 

9.4.2 Time Code Interpretation 

The time is represented in binary-coded decimal. It represents civil time, including summer 
time adjustments. The time transmitted is the time of the following minute; e.g. during 
December 31 23:59, the transmitted time encodes January 1 00:00.  

The first 20 seconds are special flags. The minutes are encoded in seconds 21–28, hours 
during seconds 29–34, and the date during seconds 36–58. 

Two flags warn of changes to occur at the end of the current hour: a change of time zones, 
and a leap second insertion. These flags are set during the hour up to the event. This 
includes the last minute before the event, during which the other time code bits (including 
the time zone indicator bits) encode the time of the first minute after the event. 

Bit ID Description 

:00  Start of Minute. Always 0. 

:01  Civil warning bit. 

:02  Civil warning bit. 

https://en.wikipedia.org/wiki/Binary-coded_decimal
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:03 
 

Civil warning bit. 

:04  Civil warning bit. 

:05 
 

Civil warning bit. 

:06  Civil warning bit. 

:07  Civil warning bit. 

:08  Civil warning bit. 

:09  Civil warning bit. 

:10  Civil warning bit. 

:11  Civil warning bit. 

:12  Civil warning bit. 

:13  Civil warning bit. 

:14  Civil warning bit. 

:15 R Abnormal operation 

:16 A1 Summer time announcement. Set during hour before change. 

:17 Z1 Set to 1 when CEST is in effect. 

:18 Z2 Set to 1 when CST is in effect. 

:19 A2 Leap second announcement. Set during hour before leap second. 

:20 S Start of encoded time. Always 1. 

:21 1 Minutes (0-59) 

:22 2 Minutes (0-59) 

:23 4 Minutes (0-59) 

:24 8 Minutes (0-59) 

:25 10 Minutes (0-59) 
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:26 20 Minutes (0-59) 

:27 40 Minutes (0-59) 

:28 P1 Even parity over minutes, bits 21 – 28. 

:29 1 Hours (0-23) 

:30 2 Hours (0-23) 

:31 4 Hours (0-23) 

:32 8 Hours (0-23) 

:33 10 Hours (0-23) 

:34 20 Hours (0-23) 

:35 P2 Even parity over hours, bits 29 – 35. 

:36 1 Day of Month (1 – 31) 

:37 2 Day of Month (1 – 31) 

:38 4 Day of Month (1 – 31) 

:39 8 Day of Month (1 – 31) 

:40 10 Day of Month (1 – 31) 

:41 20 Day of Month (1 – 31) 

:42 1 Day of Week (Monday = 1, Sunday = 7) 

:43 2 Day of Week (Monday = 1, Sunday = 7) 

:44 4 Day of Week (Monday = 1, Sunday = 7) 

:45 1 Month (1 – 12) 

:46 2 Month (1 – 12) 

:47 4 Month (1 – 12) 

:48 8 Month (1 – 12) 
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:49 10 Month (1 – 12) 

:50 1 Year (0 – 99) 

:51 2 Year (0 – 99) 

:52 4 Year (0 – 99) 

:53 8 Year (0 – 99) 

:54 10 Year (0 – 99) 

:55 20 Year (0 – 99) 

:56 40 Year (0 – 99) 

:57 80 Year (0 – 99) 

:58 P3 Even parity over date, bits 36 – 58. 

:59  No pulse sent. 

In the event of an added leap second, a 0-bit is inserted during second 59, and the special 
missing bit is transmitted during the leap second itself, second 60.  

Although the time code only includes two digits of year, it is possible to deduce two bits of 
century using the day of week. There is still a 400-year ambiguity, as the Gregorian 
calendar repeats weeks every 400 years, but this is sufficient to determine which years 
ending in 00 are leap years.  

The time zone bits can be considered a binary-coded representation of the UTC offset. Z1 set 
indicates UTC+2, while Z2 indicates UTC+1. 
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